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InfoAssist+ Tutorials  
With InfoAssist, you can quickly and easily: 
 

• Generate Business Intelligence reports, charts, and documents from any enterprise 
information source without IT interaction. 

• Complete tasks, such as building a report, with minimal clicks. 

• Convert reports to charts, or charts to reports, in a single click. 

• Output report data in a variety of formats, including HTML, Active Reports, active Flash, 
PDF, active PDF, Excel, and PowerPoint. 

 
In Section 1 - Creating Reports, you will create several of these types of reports using the 
InfoAssist+ report interface. 
 
PLEASE READ THIS:  
 
These tutorials were built with the Version 2.2.1 level of Db2 Web Query. If you are running 
Version 2.3.0 you have some choices about how you want to invoke InfoAssist and take the 

tutorials. We recommend choice 2 below       :  

 
Choice 1:  Use the Legacy Mode of Db2 Web Query 2.3.0 
 
Sign on directly to the legacy home page:   
 

• Bring up a browser 

• Instead of using the standard sign on URL use this one instead:  

http://your.system.name.com:12331/legacyhome   

• Sign on using your IBM i userid and password 

 
Or,  you can sign on using the normal URL: http://your.system.name.com:12331/webquery  
 
 

• After signing in, click on  your user ID in 
the upper right-hand corner and select 
“Legacy Homepage.”   

 

• This will open up the Version 2.2.1 BI Portal 
user interface in a new browser tab and you 
should be able to follow along with this 
tutorial from here.  

 
 
 

http://your.system.name.com:12331/legacyhome
http://your.system.name.com:12331/webquery
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Choice 2:  Be ADVENTUROUS (We recommend this)!  
 
Use the new Home Page and Workspace interfaces to invoke InfoAssist. Assuming you have 
installed Db2 Web Query with EZ-Install 2.3.0 AND that you have gone through the TEST DRIVE, 
it should be fairly easy to navigate through these tutorials from the Home Page and Workspaces 
views. For instance, sign into web query home page:  
 
Click on Workspaces.  
 

 
 
 
Assuming you finished the TEST DRIVE tutorial, you should already have created a Db2 Web 
Query Training workspace and your own sub-folder. Make sure you navigate to the Db2 Web 
Query Training workspace by double clicking it, and also double click on your sub-folder:  
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From here you can just click on the REPORT to open up InfoAssist and continue on with these 
tutorials in section 1.1.2, step 2! 
 
BE ADVENTUREOUS!  Note references to Top Level Folders in 2.2.1 equates to “Workspaces” in 
2.3.0, and references to the BI Portal equate to the new Home Page in 2.3.0.  
 
If you have any issues feel free to reach out to the Db2 Web Query team at QU2@us.ibm.com.  
 
  

mailto:QU2@us.ibm.com
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1 Creating Reports 

1.1 InfoAssist+ Environment 

1.1.1 How to Create your Tutorial Folder 

You can create InfoAssist+ reports from both Developer Workbench and a browser.  The following 
screens and instructions depict starting from a browser window.  You can create the folder and 
start InfoAssist+ from within Developer Workbench if you have Developer Workbench available to 
you. 

 
Bring up a browser 

Go to http://your.system.name:12331/webquery   

Sign on using your IBM i userid and password 
 

Your IBM i user profile has already been registered as a licensed Db2 Web Query user 
and has development access to the top-level folder named Common (hidden) and Db2 
Web Query Training. 

 

  

http://your.system.name:12331/webquery
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Right-click on the Db2 Web Query Training top level folder and select New→Folder.  
  

 

 

Name the new folder using your name or initials. This is where you will store your work.  
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1.1.2 How to Start InfoAssist 

 

1. Right-click the folder you created in the previous step and select New→Report 

 

 
In the next window you’ll see a list of application folders that contain the Century 
Electronics synonyms.  

 

Synonym is the term that Db2 Web Query uses to describe the files, tables, views, etc. 
that  have been made available for building reports or charts.  

 

In Db2 Web Query, you will build your reports using these synonyms.  

 

2. Open up the century_electronics application folder by double clicking on it. 
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3. The synonym we want to use for this new report is CEN_ORDERS.  Select CEN_ORDERS 
synonym from the list of synonyms and click Open. 

 
 

4. The InfoAssist+ report editor is opened in the browser. You can now begin building your 
new report. 
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1.1.3 Setting your User Options 

The User Options panel allows you to set defaults for your InfoAssist+ environment. 
For example, you might wish to change the default Data Panel View from Logical to 
List, reduce the number of rows being sampled for Live Preview from 500 to 50, or 
change the default output type of a new report from HTML to Active Report.  

 

You can also change these settings within the InfoAssist+ editor session, but the scope 
of the change will apply only to the particular report being edited.  

 

When you change the defaults using the User Options panel, the selected defaults are 
in effect for all new edit sessions.  

 

Let’s take a look at how you can change the default User Options.  

1. Click on the Main Menu icon   located in the upper left corner of the InfoAssist+ 
editor panel. 

 
 

In the Main Menu panel that is displayed, click on the Options button located in the 
lower right corner. 
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The Options panel is displayed. The values on this panel can be modified to reflect 
your user preferences.  

 
 

On the Data Panel option, if not already selected, choose Logical view, and click OK. 

 

 

Again, changing the user options lets you set the defaults for your InfoAssist+ 
environment. You can always change these settings within your InfoAssist+ editor 
session, but then the scope is just for that particular report.   
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Let’s take a look at how we can change the Data Panel option for just the current 
InfoAssist+ session. 

 

Click on the View tab within InfoAssist: 

 

 

If necessary, expand the Data Panel section, and confirm that the Logical button icon 
is selected: 

 

 

Note that the background of the selected button (Logical button, in this case) is 
highlighted to indicate that it is the currently enabled option. Also note that background 
colors may be different when using different browsers. 
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If you scroll up and down in the Data panel on the left-hand side, you’ll see the 
columns/fields that you can use when building a report. 

 

 

Several of the columns are placed inside a dimensional structure. These are marked by 
the    and     icons in the Data Panel tree.  

 

You can expand and collapse the dimension columns using these icons. You can also 
scroll up and down through the Data Panel.  

 

 

 

 

Continue to the next section to create your first report. 

 

Note: As  you work through the exercises, you may encounter instructions that ask 
you to select a column/field that  you do not see it in the Data Panel. Be sure to use 
the expand buttons and/or scroll capabilities within the Data panel to look for it! 
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1.2 Creating a Summary Report (IA1_Revenue) 

The InfoAssist+ user interface is fairly intuitive. The tab-based ribbon style toolbar logically groups 
all functions and makes it easy to find the options you need. 
 
InfoAssist+ has built-in intelligence throughout its interface. Toolbars collapse and expand to fit 
the screen. The ribbon updates as you click in different areas of a report. Data fields are logically 
categorized as dimensions and measures. You will see this in action as you work through the 
exercises. 

1.2.1 How to Create an Initial Report 

Scroll down in the Data panel to the Product Info section 

  

 

Expand the Product Info dimension so that you can see Product Type, Product 
Category, Model and Product Name. 
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There are three ways that you can add a new field to your report: 

1. Double click on the field name in the Data Panel 

2. Drag the field from the Data Panel to the Live Preview panel 

3. Drag the field from the Data Panel to the Query panel 

 

Click on Product Type in the Data panel and drag-and-drop it to the by section of the 
Query panel.  

  

 

 

 

  

Query panel - By section: 

• When the Query panel is set to Sum, the report output will be grouped 
and ordered by the column(s) placed in the By section of the Query 
panel.  

• When the Query panel is set to Print, the report output is only ordered 
by the column(s) selected. 
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Scroll  up in the Data panel until you see the Measures heading at the top of the list.  

  

 

 
 

 

 

Using the Data panel, double-click Revenue to add it to your report.  

  

 

  

Logical view:  

When using the Logical view, all numeric fields are grouped 
together under Measures 
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Because the value that was double-clicked (Revenue) is a Measure, Db2 Web Query 
will automatically place it into the Sum section of the report. Db2 Web Query assumes 
that any Measures double-clicked for use in a report are intended to be summed. While 
this is the desired use of Revenue for this report, summarization of all Measures is not 
always the desired or intended action.    

 

NOTE: If you dragged that field over into the Query panel, and dropped it in the wrong 
spot, you can always click, hold, and drag it into your intended location. But be aware – 
if you drag it OVER another field, it will REPLACE that field in the query panel (you get 
dotted lines hovering over the field to be replaced in that instance)! 

 

 

 

Next, let’s add grand totals for Revenue to our report. Click on the Home tab. 

  

 

If the Report group is not already expanded, click the Report icon on the ribbon to 
expand it and see the Report options available. 
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This is an example showing how the toolbar will collapse or expand based on the width 
of the screen. After you have opened some of the tabs, such as Report, if you then 
narrow the width of your screen the system will automatically condense some of the 
tabs on the ribbon so that the ribbon will fit. 

 

 

8. Click Column Totals in the expanded Report ribbon. 

  

 

9. Selecting Column Totals adds a grand total row to the bottom of the report for 
all numeric data columns. 
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Selecting Row Totals would add a grand total column to the right side of the report 
containing the sum of all the numeric data for each row in the report.  

Column Totals 
The columns and their TOTAL row calculation (Sum, Avg, etc.) can also be 
customized by clicking on the down-arrow icon for Column Totals and selecting 
More options… 
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1.2.2 How to Save your report 

 

Next, we want to save our report.  Click the Save  icon at the top of the window 

 

 

Name the report IA1_Revenue and click Save.  
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1.2.3 How to Run your report 

 

To run a report that is open in InfoAssist+, click the Run  button. 

  

 

Notice the new tab at the bottom of your screen labeled IA1_Revenue(0). This tab is 
called the Results View and displays the report’s full run results. The Results View 
report looks the same as the Live Preview report except that the numbers shown are 
different. This is because the Results View contains the results using all of your data 
instead of only the sample of the first 500 rows of data shown in the Live Preview 
window.  

 

 

You can switch between the Live Preview and the Results View by selecting the 
appropriate tab at the bottom of the panel.  
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With the IA1_Revenue(0)  Results View window selected,  close the results panel by 
clicking on the x  icon in the upper right-hand corner of the Results View window. 

 

 

 The Live Preview window is again displayed and is now the only open window. 

 



                                            
_____________________________________________________________________________ 

Page 25                                                                                      © 2019 IBM Corporation 

 

1.2.4 How to Format a Column 

To change the format of the Revenue column, click the Revenue field in the Query 
panel. 

This opens the Field tab for the Revenue column. Note that the tab is labeled Field – 
Revenue.  

When you select the Revenue field, the ribbon becomes field specific. Some of the 
groupings may already be expanded depending on the width of your screen. In this 
screen shot, the Format section is already expanded. Depending on the size of your 
browser window and the resolution of your screen, you may need to click on the Format 
button to expand the Format section. 

 

 

The Field tab is where you COULD set formatting attributes of the Revenue field. For 
instance, you could add a $ sign and insert commas as the thousand’s separator.  

 

However, Db2 Web Query allows you to do this formatting of a field within the synonym, 
which is what we have done for our example. This lab doesn’t cover working with 
synonyms, but the point is that one could edit the Revenue column format in the 
synonym so that every time Revenue is used in a report it already has the desired 
default format and characteristics. Setting the format in the synonym saves time vs. 
having to add these format changes in each and every report.  

 

We won’t change the format in this report, and we’ll leave the meta data format change 
up to the meta data administrator. Let’s continue on.    
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1.2.5 How to Create a Detail Listing 

 
In this section, you will look at the difference between the Sum and Print options in the Query 
panel.  
 
The Sum option is the default and was used to produce our initial summary report. That report 
was aggregated or summed on the PRODUCTTYPE field.  
 
The Print option turns off aggregation and produces a detail listing. Each row read from the data 
file is printed on the report. 
 

Right-click Report (cen_orders) in the Query panel. 

Select Print. 

 

 
The Print option creates a detailed report that includes one row for each selected 
record. The Sum option consolidates your records, summing or aggregating numeric 
fields by your sort column(s).  
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Notice that instead of one total record for Audio products, the Print option displays one 
line for every individual record in the Order Detail file. 
 
For the remainder of this lab, you will be creating summary reports so we will return the 
report to the Sum option.  

 

Return to the summary report by right-clicking Report (cen_orders) and selecting Sum. 
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1.2.7 How to Use Aggregation Functions 

In this section, you will use the aggregation functions to add a count of the number of orders for 
each product type to your report. 

 

Locate Order Number in the Data panel and select it with a left-mouse click. 

Drag and drop Order Number to the Sum section of the Query panel – placing it just 
below Revenue. 

 

Note that when you do this, the MAX. function is automatically added to the Order 
Number column because you are adding a non-numeric column (Order Number) to the 
Sum section – and non-numeric columns cannot be summed. 
 
And again, you could instead drag Order Number directly onto the Live Preview report 
or double-click Order Number to add it to the report.  

 

 

We are interested in the CNT. (count) of Order Number, not its MAX. Right-click on 
MAX.Order,Number in the Query panel to open its field-specific submenu. 
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Select More, then Aggregation Functions and then Count. 

  

 

The count of the Order Number (CNT.Order,Number) by Product Type is now displayed 
in the Live Preview. 
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You decide that you now want to move the Order Number field before the Revenue 
field. This next section shows you how to reorder your fields if they aren't in the 
sequence you want. 
 

Select the Order Number field in the Live Preview panel.  
 
Notice that an outline is drawn around the field and its values.  

  

 

Drag the field to the left of the Revenue column. 
 
A vertical bar will appear, indicating where the field will be positioned when you release 
the mouse button. 
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Because you positioned the COUNT Order Number column between the By column 
Product Type and the Sum column Revenue, an additional menu appears. The 
options are Drop as Sort or Drop as Sum.  

 

 

Drop as Sort places the selected column into the By section. Drop as Sum places the 
selected column into the Sum section. 

 

Select Drop as Sum. 
 

 

 

 
 

To create a new heading in the Query panel, right-click Cnt.OrderNumber to see the 
field specific submenu.  

 

Select Change Title… , type the new title Order Count, then click OK. 

 
 

  

Moving columns 
You can also reposition the Order Number column by dragging Order Number 
above Revenue in the Query panel. 
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 Run  the report. 

  

 
You have completed your initial summary report. You will return to this report later. 

 

Close the IA1_Revenue(0) run window and return to the Live Preview window.  

 

 

Save  your report. 
 
 
 
We will continue to use this report as the basis for our next report. 
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1.2.8 How to Use Auto Drill & Analysis 

Online analytical processing (OLAP) is best known as the technology that allows a user to slice 
and dice data or drill down into data. Db2 Web Query makes it easy to provide users with a 
sophisticated drill-down, slice and dice interface.  
 
In order to enable this feature, you must ensure a global setting has been turned on. Its possible 
that you did this step previously, but to do this, sign on as a Db2 Web Query administrator.  
 
Navigate to the Administrator functions in the upper right-hand corner and select “Administration 
Console.” A new window should open. Look for OTHER in the left-hand panel and select that. 
Check the OLAP option if not already checked, and then hit save. Then click Clear Cache at the 
top of the Admin Console. Sign out and sign back in again.  
 
This is just a brief taste of the powerful OLAP functions.  Please see the Db2 Web Query 
Redbook tutorials for a more comprehensive OLAP tutorial. 
 

Select the Format tab  

 

 

Expand the Navigation group if it is compressed. 

 
 

Click the down arrow on the right-hand side of the Auto Drill & Analysis button. Select 
More options in the drop-down. 
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In the Auto Drill and & Analysis panel, select Dimensions grouped in tabs under 
OLAP options, and Dimensions under the Auto drill options. Click OK. 

  

 

Run your report. Note: We will not be saving this OLAP version of our report.  
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The Product Type column is automatically highlighted and underlined; this indicates 
that you can drill down on this column. Click Audio. 

 
 

The Product Category breakdown for Product Type = Audio is shown. 

 

 

How does Db2 Web Query know that Product Category is the hierarchy level below 
Product Type? This is another example of the power of a synonyms. In our case, our 
CEN_ORDERS synonym has this hierarchical structure defined within it. When OLAP is 
enabled in the report, Db2 Web Query uses the hierarchy information in the synonym to 
understand that when a Product Type is clicked on and drilled into, the next level that 
should be shown is its Product Category.   
 
Auto Drill & Analysis is a feature that you can turn on with any report if you have the 
OLAP hierarchy information defined enabled in your synonym. 
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Auto Drill & Analysis has much more power than the simple example you just executed. 
But for now, let’s move onto other report writing features (there are a lot more tutorials 
in the IBM Redbook or other labs)! 

 

Close the Results View window.  

 
  

Under the Navigation section, turn off Auto Drill & Analysis by clicking on the Table 
icon.  

 

 

This IA1_Revenue report is the basis for the following Crosstab report. 
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1.3 Creating a Cross-Tab Report (IA2_XTab) 

In this section, you will modify the initial report to select only the rows for a particular order date 
year and display the results in columns under each quarter. 

1.3.1 Adding a Constant Filter to a Report 

If you closed the InfoAssist+ editor or Db2 Web Query browser window, first log 
back on and locate the report you just created under your subfolder within the Db2 Web 
Query Training folder. Right-click the report - IA1_Revenue - and select Edit. 

 

 

With the InfoAssist+ editor open to your IA1_Revenue report, expand the Order Date 
Hierarchy in the Data panel (twice) and drag Order Year to the Filter panel.  
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The Filter window will open automatically. There could be some differences in the 
following navigation based on which browser you’re using. For instance, if you only see 
this screen next:  

 

 

Then you should double click on the <Value> to get a drop down, then single click on 
that drop down (wait a few seconds) and the following dialog box will appear. For other 
browsers, like IE, this dialog box appears by default.  

 

 

 

Click on the  Get Values drop down and then ALL to bring in the current years from the 
sample database. 
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Select the first year from the list and click the double right arrow button  to add the 
first year value to the Multiple Values: filter list. Click OK. 

 

 

 

 

 

 

 

 

Click OK on the Create a filtering condition panel to close it.  

 
 

We’ve added the Order Year filter. Next, we will add the cross tab by Order Quarter.  

NOTE: The sample database used contains 2 years of data. Depending on the 
version of the sample database is loaded/restored, you may see different years than 
those shown here. If so, you can either choose to change those dates to match or 
just use the earlier of the 2 years shown. When you get to the charting lab, 
however, we will want these 2 years to be the CURRENT YEAR and previous year in 
order for all of our charts to display correctly. 
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1.3.2 How to Create a Cross-Tab Report 

Next you are going to break down annual sales by quarter and display the quarters across the top 
of the report. In the set up for this lab, Order Date was broken down (decomposed) into its date 
components in the synonym - the columns Order Year, Order Quarter, Order Month and Order 
Day are already available to you and do not have to be created in every report. 
 

Drag Order Qtr to the Across section of the Query panel. 

 

 

To change the heading, right-click Order Qtr in the Query Panel and select Change 
Title 
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Type Quarter as the new column heading and click OK 

 

Now let’s save this report under a different name. Click the   Main Menu icon in the 
upper left corner and then select Save As.  

  

 

Enter the report name IA2_XTab and click Save. 
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Next, click Run  to run the report: 

 

 

Close the report IA2-XTab(0) Results View window. 

 

Now we will close the saved report but leave InfoAssist+ editor open. From the Main 

Menu  , click on Close  to close the IA2_XTab report. 
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The InfoAssist+ editor window remains open.  

 

 

Next, we will create a new report starting from this open InfoAssist+ editor window.  
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1.4 Creating a More Complex Report (IA3_GrossPft) 

In this tutorial, you will create a report that will be the basis of the remaining reports for Section 1.  
 

For this report, you will add four columns: Product Type, Product Category, Revenue and 
Cost of Goods Sold. You will also calculate a Gross Profit column.  

1.4.1 How to Create a Report with a Compute field 

Click the New Report  button 

  

 

On the InfoAssist+ panel, click Build a Report 
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Select the cen_orders synonym and click Open 

 

 

Expand the Product_INFO hierarchy. 
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Click Product Type.  Then holding down the Ctrl key, click Product Category. Scroll 
up into the Measures section and, still holding down Ctrl key click on Revenue and 
finally Cost of Goods Sold. You should now have all four of these columns selected 

 

Now drag and drop these selected fields onto the Live Preview window. 

 
Next you can add grand totals to the report. 

 

Click Home tab on the toolbar to open the Home ribbon. 

Expand the Report group if required.  

Click Column Totals.  

 

  

Adding report columns 
You can double click each field required individually or you can select all the fields at 
once in the desired sequence and drag and drop them on your canvas.  Note that the 
sequence you select the fields is the sequence they will appear in your report. 
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Now you will add a new calculated field called Gross_Profit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Data on the toolbar to open the Data ribbon. 
 

Click Summary (Compute) 

 
 

  

Define vs. Compute 
There are two types of calculated fields in Db2 Web Query – Define fields and 
Compute fields. 
 
When you create a Define field, you add the definition of the field to the list of 
fields within the table. This field is calculated every time a record is read from 
the data. 

 
The other option is to create a Compute field. In this case, the field is not 
calculated until after the data is sorted and all aggregation is complete. 
Compute fields are evaluated just prior to the row being printed onto the report. 
Compute fields are typically required for percentages and variances. 
 
If you want to sort or filter based on a calculated field, then you must create a 
Define field. In most other cases you can create a Compute field, which should 
perform better because you are calculating it based on the number of output 
records. A Define field is calculated for every input record. 
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The Summary Field (COMPUTE) panel is displayed. Type Field name Gross_Profit. 

 

 

Click the Format button. 

 

 

  



                                            
_____________________________________________________________________________ 

Page 51                                                                                      © 2019 IBM Corporation 

 

The Field Format Options panel is displayed. Using this panel, you can specify 
additional output formatting for this new Compute value. We want this new field to be 
integer, up to 10 digits long, commas added as needed and a floating currency symbol 
of $. 

 

Select Field type of Integer, Field length (1-11) of 10, select Use Comma (C), and select 
Floating Currency from the Currency Symbol drop-down. Click OK. 

  

  

 

 

 

 

 

 

 

  

Format shortcut 

Advanced users can bypass the Field Format Options panel and directly enter 
I10MC in the Summary Field (COMPUTE) Format text box 
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Now we will build the definition of our new Gross_Margin COMPUTE column.  

 

Our calculation for Gross_Profit will be Revenue – Cost of Goods Sold 

 

In the field list on the right, double-click on Revenue. This places the Revenue column 
(noted as “Revenue”) into the formula calculation window 

 

 

Place your cursor next to “Revenue” in the formula area and click on the minus button 

.  
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Now double-click Cost of, Goods Sold. This places the Cost of Goods Sold field 
(field name COSTOFGOODSSOLD) into the formula calculation window 

 

 

While you are in this wizard, you can click on the function icon  in the upper right 
corner to see the functions that are available to your calculation.  
  

 
You can use IF/THEN/ELSE logic as well as manipulate your dates, numbers, or 
character strings. Selecting a function will prompt you for the required parameters.  

 

We will not be including any functions into this report.  
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Click OK to complete the formula.  

 
Notice that InfoAssist+ automatically added the new Compute field as a column in the 
report. Gross_Profit has a column heading of the same name. If you want a different 
column heading, you could right-click on the Gross_Profit field and select Change 
Title. 

 

 

Click the Save button and name the report IA3_GrossPft 
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1.4.2 Using Traffic Lighting (Conditional Styling) 

On this same report, we want to highlight Gross Profit to indicate products that generate high or 
low profits for the company. 
 

Click Gross Profit in the Live Preview panel. 
 
This will update the ribbon toolbar to be specific to activities for the compute field Gross 
Profit. 

 

 

Traffic Lighting or Conditional Styling is located in the Display group. Click on Display 
to expand that ribbon group if necessary. 
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Click Traffic Lights. 

 
We want to set up traffic lighting so that your field displays with a green background if 
the Gross Profit for that product category is more than 30 million. If the Gross Profit is 
less than 15 million the field should be displayed with a red background. 

 

Leave the initial condition as "Greater than", enter 30000000 (30 million) and click OK. 

 
 

Click on the Style button to change the background for when this condition is true. 
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Click on the Background Color button 

 

 

From the Color palette presented, click on a green shade. In the bottom right of the 
screen you see the Preview of how this style would appear in the report. Click OK. 

 
 

To add a second condition for the field Gross Profit, click the New button 
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Leave the condition of "Less than" and enter a value of 15000000 (15 million). Click 
OK. 

 

 

Using same steps as described above, change the background color for this condition 
to Red. Click OK. 
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Recall that when you see the report in the Live Preview, you are only looking at the first 

500 records. Run  the report to verify that your traffic light conditions are correct 

  
 
 

 

 

 

Save  your report. 

 

  

More on traffic lighting 

If you wished to highlight Gross Profit when it is over/under a percentage of 
Revenue you would need to create a work field containing the percentage value.  
You could then highlight Gross Profit based on the values in the work field. 
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1.4.3 Using Variables in Report Headings and Footings 

In this section you will enhance the report by adding a header and footer and including date and 
time system variables. 
 

Select the Home tab. 

 

Expand the Report section if it is compressed. 
 

From the Report section, select Header & Footer.  

 

 

The Header & Footer panel is displayed. With Report Header selected, type Gross 
Profit by Product Category. 
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Click Report Footer and type Prepared on &DATE at &TOD. 
&DATE and &TOD are system variables you can leverage in your report 
headings/footers. This will print the date and time of day that the report was produced at 
the end of the report.  

You can find more variations by clicking on the Insert Preformatted Text  icon.  

Click OK to save your Heading & Footing changes 

 

 

Run  the report. 

 
Notice the default format for the date is mm/dd/yy.   Next you will make this more 
readable. 
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Close the Report Results window and return to the Live Preview window. 

 

To modify the footer, click Header & Footer. 

 

Select Report Footer. 
 
When formatting a date with Web Query, M stands for the two digit month, D for the two 
digit day, and Y for the two digit year or YY for the four digit year.  
 
You can use system variables to format the date differently. To add the three character 
name to the day or month, add the letter t after the M or D. For example, Mt would print 
as Aug or Dec. Adding an r after the t displays the long form of the name. These rules 
are explained in the Web Query manual and in the Redbook. 

 

Change &DATE to &DATEMtrDYY and click OK to save the changes. 

 
 

Save  your report. The name of the report is still IA3_GrossPft 
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Run  the report. 

  
 
Note the new date format.  

 

Close your Report Results window by clicking the Close   button. 
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2 Additional InfoAssist+ Features 
This section investigates different options available with Db2 Web Query and InfoAssist. You will 
continue working with IA3_GrossPft report as the starting point. Do not save the report changes 
in this section as you will need IA3_GrossPft later. If you wish to take a break while you are 
testing the additional functionality, save your work under a new name and come back later and 
open your saved version. 

2.1 How to Insert a Line Break 

Insert a line break whenever the Product type changes. 
 

Select Product Type. This will open the Field – Product Type tab. 

 

Expand the Break group in the field specific ribbon if it is compressed. 

Select Line Break 
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Note that the report now contains a line break after each Product Type. 

 

 

Click Line Break again to turn it off. 
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2.2 How to Sort a Sum Field 

Assume that you would like this report sorted by Gross Profit within Product Type. 
You can do this in a variety of different ways. Here is one method 

 

Click the Gross Profit column. This opens up the Field specific tab for Gross Profit. If 
the Sort group is not open, expand it.  

Click on the Down button. This sorts the entire report by Gross Profit descending. 

 

 

Look at the Query panel. Note that when you made Gross Profit a sort column, 
InfoAssist+ automatically inserted Gross Profit as the first By column and made it 
hidden. 
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Next you want to change the sort orders, making Product Type the primary sort 
column, and then Gross Profit within Product Type. 

 

In the Query Panel, select Product Type and drag it above Gross Profit. 

 

 

Product Type now appears above Gross Profit in the By section. You can see in the 
Live Preview window that Gross Profit is now sorted in descending order within 
Product Type. 
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2.3 How to Add Ranking Columns 

In addition to sorting by Gross Profit you can rank by Gross Profit. 
 

In the Query panel, click the Gross_Profit column in the By section. This sets the 
Field specific tab to the Gross_Profit field. 

  

 

Click the Rank button in the Sort section. The results are now ranked by Gross Profit 
within Product Type.  

 
If you wanted a Top 10 report, you would change the Limit field next to the Ranking to 
10. 
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2.4 How to Generate Subtotals 

Next add subtotals to the report. 
 

Select Product Type from the Live Preview window or Query Panel view. This action 
opens the Field specific tab for Product Type.  

 

 

If required, expand the Break group. 

 

Click Subtotal. 
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Run  the report. 

 

 

You can also select which measure columns to subtotal as well as customize the 
subtotal text. Make sure the Product Type column is selected in the Live Preview 
pane (make sure you close the run window and are working back in the Live Preview 
pane). Click on the the small down arrow/triangle icon next to the Subtotal button and 
select More options: 
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The Subtotal dialog window is presented. Make sure the RECOMPUTED radio button is 
selected. Type “Subtotal for Product Type: “ in Current Subtotal text. Notice that you 
can select what measure columns are subtotaled by unchecking Subtotal all fields and 
checking any of the individual columns. Before clicking OK, make sure Subtotal all 
fields is checked again. 

 

 

Click OK 

Run  the report. 
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2.5 How to Generate Pages on Demand 

Our sample report is not the best to demonstrate the Pages on Demand feature (because there is 
not that much data returned), but you will see the options that are available. Imagine that your 
report is 200 pages long instead of just a single page. When Pages on Demand is activated, Db2 
Web Query saves your report on the IBM i and delivers one page of report output at a time to your 
browser. This not only decreases the amount of time that you wait for your report to be transmitted 
but it greatly reduces the browser memory requirements. The bulk of your report remains on the 
IBM i until you request a page or until you close the report. Pages on Demand allows you to jump 
directly to a specific page or to have the IBM i search for a string of information in the report and 
return only the page with the first occurrence of the sort string. 
 

Open the Format ribbon and expand Navigation if required. Click the Pages on 
Demand button in the Navigation group. 

 

 

Run  the report. 

 
Note that you can directly enter a page number that you want to jump to, or you can 
enter a search string to find. 
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Enter MiniDV in the Search panel and click the Find button . 
 
The page containing the first occurrence in the report of MiniDV is displayed and that 
occurrence is underlined. 

 

 

Close the Report Results window. 

 

Click on the Live Preview tab at the bottom left to see your Live Preview window 
again. 

 

Let’s remove the Pages on Demand feature and return to the Table navigation type. If 
the Navigation group isn't expanded, expand it now. 

 

Click the Table button. This returns your report to the default table output type. 
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2.6 How to Stack Measures 

A nice addition to Db2 Web Query with InfoAssist+ is the capability, when designing a report, to 
request that your numeric fields are stacked on top of one another instead of laid out next to each 
other across the report. This is especially true when using the Across section, since Across 
tends to require a lot of horizontal report space. 
 

Expand Features on the Format ribbon.  

 

 

Click Stack Measures 

 

 

Run  the report. 
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Close your Report Results window. 

 

Remove Stack Measures by clicking Stack Measures again. 

  

Report Themes 

In these tutorials, all report output is using the default report theme or 
template. 
 
There are many other themes for you to choose from.  These can be found 
under the Home tab, in the Report group under Theme.   

 
 
From the Theme window select Template and you will see all the templates or 
themes shipped with InfoAssist.  For example, you could try using theme 
ENocean_theme.sty if you wish. 
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2.7 How to Output Reports in PDF 

 

To change your report to PDF, select the Home tab.  

 

 

Expand the Format section and select PDF  
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Run  the report. It displays as a pdf document. 

 

 

Close your Report Results window.  
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2.8 How to Output Reports in Microsoft Excel 

There are multiple choices for outputting reports to Excel. A very easy option is to download a 
report to Excel, complete with formulas, by changing your report Output Type to one of the Excel 
options that use formulas. With this choice, the totals and subtotals, as well as many of the 
compute fields, are represented as Excel formulas instead of static values. This allows these 
columns to reflect accurate results even after the user modifies the worksheet. 
 
Before selecting Excel as the output format, it is best to ensure that the Product Type values are 
repeated on every line. By default, InfoAssist+ does not repeat identical sort by values for 
aesthetic reasons. When you send the data to a spreadsheet, you will probably want to fill in every 
row completely. 
 

You should still be on the Format ribbon, if not select Format to open the ribbon, and 
then expand Features. 

 

Select Repeat Sort Value. 

 

 

On the Home tab Format section, click the drop-down arrow  next to the output type 
shown (.pdf, html, etc.). Then click Excel (xlsx) > Excel Formula(xlsx).  
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Run  the report.   
 
The report is run, excel output is generated and transferred to the desktop, and then 
you will see this prompt: 

 

 

Select Open and the file is opened in Excel. You might need to widen your columns 
once Excel is populated with the result set to see real numbers vs. the “####” which 
indicates the data is wider than the column.  

 
Notice the total for Cost of Goods Sold in cell E24. If you look at the Excel input line, 
you see that this is represented as a formula as opposed to an actual value of 
$1,129,157,915.00. This is a helpful feature for users who want to download reports and 
then analyze the data and possibly modify some values. Having formulas instead of 
actual numbers in your report allows field values to be recomputed automatically. If you 
want to see the constant values downloaded, then choose Excel (xlsx) or Excel as 
your output type. 
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The following image is an example of InfoAssist+ changing a calculated field into an 
Excel formula. Remember that you created Gross_Profit by specifying LINETOTAL - 
COSTOFGOODSSOLD. Since you chose to do this as a Summary/Compute 
calculation, Web Query can convert it to an Excel formula. If you had created 
Gross_Profit as a Detail/Define calculation, it would appear as part of the input record 
and we would not see the calculation here. 

 

 

Close the spreadsheet. 
 

Go back to the InfoAssist+ editor panel, and Save As the report as 
IA4_GrossPft_with_Subtotaling 
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Change your Output Format from Excel to HTML. 

 

 

Turn off the Repeat Sort Values by clicking on the button again. 
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2.9 How to Create a Table of Contents 

The Table of Contents option is activated only when HTML, Active Report, Excel, or PowerPoint 
Output Format is selected. 
 
 
 
 
 
 
 
  
 
First you will remove the Gross Profit sort and ranking column from this version of the report. 
 

Right-click Gross_Profit under By in the Query Panel and select Delete. 

 

 

Open the Format ribbon, expand the Navigation group and select Table of Contents. 

 
 

  

Table of Contents and Excel output – multiple worksheets 
If Table of Contents is selected with output to Excel, the resulting report output 
is placed into a separate worksheet for each of the values in the first By column 
of your report. For example, if Product Type is the first By column, each 
Product Type (Audio, Camcorders, etc.) would be on its own worksheet. This is 
a very easy way to create separate worksheets. 
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Run  the report.  

The small icon  in the top left of your report indicates that a Table of Contents is 
available. Double-click this icon.   

 

 

The Table of Contents opens in a separate window 

 

 
Selecting the table of contents icon opens a menu that enables you to select and 
display individual values of the sort fields. You can also select options to view the entire 
report or to remove the table of contents. 

 

Drag your table of contents to an area of the screen that doesn't interfere with your 
report.  
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Expand the Video section of the table of contents.  

 

 

Click the TV icon. 
 
Note that the TV row flashes for a few seconds to draw your attention to it. 
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Expand Audio and click CD Players and Recorders. 
 
Again notice that the CD Players and Recorders row flashes for a few seconds to get 
your attention.  

 

 

Select TOTAL to go to the Grand Totals at the end of your report. 
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Select the Table of Contents heading.   
This will minimize the Table of Contents. You can click and expand it when you need it. 

 

 

Save As the report as IA5_GrossPft_TOC. 

 

 

Close InfoAssist+ 
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3 Appendix 

3.1 Setup Notes 

The assumption is that your system was set up using the EZ-Install package. Synonyms for 
QWQCENT are placed into “Century Electronics” app folder, so be sure to add that into the “Db2 
Web Query Training” application path. You’ll also need to give each developer access to both the 
Db2 Web Query Training and Century Electronics –dev  and –dba roles.  

  

  


